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Opening Word 2016

e Begin by clicking on the bottom left corner icon on the desktop.

e From All Programs, click on Microsoft Office 2016 — Word 2016

¢ You have the option of selecting a blank document, opening a recent document, or choosing from a
template.

e Blank document is generally selected.

Office 2016 “Ribbon”
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o There are three parts in the Ribbon: Tabs, Groups, and Commands/Buttons. The ribbon is the
work bar located at the top of the document.

¢ Hiding and unhiding the ribbon is optional by clicking on the upper right hand corner of the page.
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Hide the Ribben. Click at the top
of the application to show it.

— | Show Tabs
Show Ribbon tabs only. Click a
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— Show Tabs and Commands
——— Show Ribbon tabs and
commands all the time.
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File Tab

¢ From the file tab you can open, save or create a new document. @
o Templates are available for multiple purposes such as: creating Letters, Resumes, Fax,

Labels, Cards and Calendars.
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e You can open existing documents by clicking on Open and browsing for your document.

Save As
e Save As is used to save your document in a specific location. It can be saved anywhere within your

computer or USB drive.
¢ |f you want to save the document with a previous version of Word so that the document is fully compatible

with that version, go to Save As and select Word 97 — 2003 Document.

File name: Basic Microsoft Office Word 2016 -
Save as type: [Wmd Document -
A Word Document
Authors:

Word Macro-Enabled Document
Word 97-2003 Document
Word Template

Word Macro-Enabled Template
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Single File Web Page
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Rich Text Format
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Word XML Document
Word 2003 XML Document
Strict Open XML Document
OpenDocument Text




Home Tab
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Mini Toolbar
¢ The easiest way to change the font of specific information is by using the Mini Toolbar. Highlight

the text, right-click for the Mini Toolbar to appear and change the font.  cibiees) -1 - 4 0« As

Copying Text B I U *f AT sy
o There are various ways to copy text: The mini tool bar.
o Select the text, right click and select copy. T .
o Select text and press Ctrl + C B

o Select text and press Copy from the home tab.

Format Painter ST
¢ You can copy the format from a text to another.

e Select the text whose format such as font, and style you want to copy.
e Click on Format Painter button.  Format Painter

o Drag the painter across the text you want to copy the format to.

Styles
¢ You have several styles to choose from.

e Select the text and click on the style you would like to add such as a heading, title or subtitle.
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Activity 1

1. Open up a blank Microsoft Word 2016 Workbook.

2. Type in the following sentence: ) 2ol -
“Welcome to Microsoft Word 2016.” e

3. Change the font face of the following sentence to Arial Black: t

Select “Microsoft Word”, click the B button to change the text into bold.
Align the text to center.
Save this document as Practice Document on the desktop.

Insert Tab
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Inserting a Page Break
e A page break places text on to a new page.

e To put a Page Break into a document, click Page Break under the Pages group
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[ |

Cover Blank | Page | Table

Page~ Page |EBreak v
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Inserting a Table
e Toinsert atable click on Table, under Tables group and hover the mouse over the boxes to get

the number of rows and columns you want to insert into the table.
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Inserting a Symbol
o Click on the small arrow under the Symbols group and select the symbol you want to insert.
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Inserting a Header and Footer ngr x = u oa
e To add a header, go to INSERT -

¢ |f the symbol you are looking for is not display, select More Symbols...

®
+
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e Choose the type of header you desire.

e The design tab will appear as soon as you begin to type your text into the header.
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To add a footer, click on the footer button in the design tab.
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Inserting and Formatting an Image.

e Click on Pictures from the Insert Tab.

¢ Browse for the image you want to insert into the document and select Insert.
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o The image will appear on the document.



e A Format Tab to edit the image appears after you click on the image.
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e The images’ position can be specifically defined: Arrange Group.
o Position: Multiple options as per the images’ location on the document is available. Any text
around it will automatically wrap around the image.
o Wrap Text: Feature used to set up how text wraps around the image.
o You can align the image on the page or rotate it.

e Cropping is also an option.
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e Layout was renamed after Page Layout in Word 2013.
e Use to set up margin size, paper size, or document Orientation.
e Click on the small diagonal arrow in the lower right-hand corner of the Page Setup group, and the

Page Setup dialog box will appear to make necessary changes.
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e The column feature allows you to split the page into two, three, left and right columns.

Breaks
e Adding several types of breaks is available.
e Adding a Page Break marks the beginning of a new page.
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e This tab is mainly used for scholarly papers, writing, and publishing purposes.
e Toinsert a citation, click on Insert Citation and select Add New Source.

) Manage Sources

@ Style APA  ~

Insert
Citation =

== Add Mew Source...
[ Add New Placeholder...

= [ Bibliography -

Create Source

Bibliography Fields for APA
Author

Title
city
State/Province
Country/Region
Year
Month
Day
[”] Show All Bibliography Fields

Tag name Example:
CNN112

Type of Source | Electronic Source

Language | Default E]

=

[V] Corporate Author |cnN

Occupy Wall Street park cleaning postponed, averts shutdown.
New York

NY

UsA

2011

October

14|

1

o Type in the information for the required fields and click OK when finished.

This Is what appears as the Electronic Source’s citation: (CNM, 2011)

e The citation then appears on the document.

Bibliography

e After adding all of the citation sources in the document, click on

£y Bibliography ~

nsert
Caption (13 Cross-reference

Bibliography and select a built-in style.
You can choose which Built-In bibliography option you would like to

use.

After selecting a style, the bibliography will appear on the document.

This Is what appears as the Electronic Source’s citation: (CNN, 2011)

Bibliography
CNN. (2011, October 14). Occupy Wall Street park cleaning postponed, averts shutdown. New York, NY,
USA.

References
CNN. (2011, October 14). Occupy Wall Street park cleaning postponed, averts shutdown. New York, NY,
USA.

Works Cited
CNN. (2011, October 14). Occupy Wall Street park cleaning postponed, averts shutdown. New York, NY,
USA.
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Bibliography
Bibliography

Chen, J. (2003). G

New York: Cor
Haas, 1. (2005). Creating a Formal Publication. Boston: Proseware, Inc.
Kramer, . D. (2006). How to Write Biblogrophies. Chicago: Adventure Works Press.

References

References

Chen, ). (2003). Cir New York: Con

Haas, J. (2005). Creating a Formal Publication. Boston: Proseware, Inc.
Kraemer, 1. . (2006). How to Write BibRogrophies, Chicago: Adventure Works Press,

Works Cited

Works Cited
Chen, J. (2003). €1

New York: Con
Haas, 1. (2005). Creating a Formal Publication. Boston: Proseware, Inc.

Kramer, ). D. (2006). How to Write BitBogrophies. Chicago: Adventure Works Press,

Em Insert Bibliography



Mailings Tab

This tab is used for creating envelopes and labels and to do the mail merge.

Basic Microsoft Office Word 2016 - Word
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Create Start Mail Merge Write & Insert Fields Preview Results Finish Acrobat

Step 1: Click Start Mail merge.
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Select Edit Higl
Recipients ~ Recipient List = Merg

Envelopes Lab

Create B

& E-mail Messages
E] Enyelopes...
r‘b Labels...
E Directory

EI Normal Word Document

* I[Sﬂ Step-by-Step Mail Merge Wizard... |

Step 2: Select Step-by-Step Mail Merge Wizard...

Mail Merge i

Select document type
What type of document are
Step 3: Select the document type. Click on Next: starting document. B
E-mail messages
Step 4: Select the document from current document, template or existing document to S
begin mail merge. Click on Next: select recipients. " o
Send letters to a group of
Step 5: Select Type a new list and click Create. ottt o pron.
Mall Merge X :{:i:::::nrmatmn in the table. To add more entries, click New Entry. S'S:i'::x;m o
[Ttle v [FrstName v [lsstName  +|Company Name v [Addressline 1 v |
Select recipients (> Doe

Use an existing list
Select from Outlook contacts f
®) Type a new list

Type a new list

Type the names and
addresses of recipients.

&; Create...
Step 3 of 6 i ! C

«
New Entry Eind..
I => Next: Write your letter I
€ Previous: Starting document

Step 6: Type in the names to create a new address list.

J

Step 7: Save the List to your files.
File name: m -

Save as type: ’Microsoft Office Address Lists =

' Hide Folders Tools v [ sawe | [ Cancel




Mail Merge Recipients [0 sl

This is the list of recipients that will be used in your merge. Use the options below to add to or change your list.

Step 8: The recipient list will appear. You can e e e B an. o e  e

. . . Data Seuce [ |Last Name | First Name. v |Tile - |Company Name | Address
sort or filter the list from here. Click OK when
you are done. Continue to step 4 of 6.

i
Data Source Refine recipient list

John_Doe.mdb a| 2| sor.
7 Eiter..
B%) Find duplicates
.| [P Find recipient.

[ Validate addresses...

Lo J

Step 9: Write your letter, position your cursor in front of the name of the recipients and click on

Greeting Line. The Insert Greeting Line will pop up. Make any necessary formatting changes and
click OK.

Insert Greeting Line ==
Greeting line format:

Dear  |=| Mr. Randall =] L [~]
Greeting line for invalid recipient names:

Dear Sir or Madam,
Preview
Here is a preview from your recipient list:

1

«GreetingLiney|
Dear Jahn Dag, |

Correct Problems

If items in your greeting line are missing or out of order, use Match Fields
to identify the correct address elements from your mailing list.

Match Fields..

N
Step 10: You can preview the name of the recipients on your letter by clicking on the ribbon: &
Preview
Dear John Dae,l Results

Step 11: Select Finish & Merge from the ribbon — Print Documents to print your merged
letters. Merging letters to Adobe PDF is also available.

e

Finish 8  Merge to
Merge= Adobe PDF

DD Edit Individual Documents...

I E:E'ﬂ Print Decuments...

EL  Send Email Messages...



Review Tab
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e Spelling and grammar can be checked from the Review tab, click Spelling & Grammar from the

Proofing group.

¢ Comments can be added to proof-read a document and make notes to share f:‘_

with others. To add a comment on a document, highlight the area where you o e e hea s

Comment Comments

Comments

want to add a comment. Click New Comment from the Comments group.

e Type the comment within the shaded comment area on the right-hand side.

EE u Basic Microsoft Office Word 2016 - Word
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P Smart  Translate Language Mew  Delete N Track o Accept Reject Compare Block Restrict

fizz] Word Count Lookup - - Comment = Show Comments Changes ~ [B] Reviewing Pane ~ - - o Authors - Editing
Proofing Insights Language Comments Tracking F] Changes Compare Protect
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]1|is area is where you should add a r.mnmnlt.l

' H Lissette) A few seconds ago =
| Add your comment in here.,

e You can hide or show the comments by clicking on Show Comments.

e Tracking changes made to a document is available.

== EH5 Al Marku - L & €] Previous
B i -

B show Markup - ; _:,j Mext
Track Accept Reject
Changes ~ [] Reviewing Pane ~ . .
IE} Track Changes I ] Changes
T & Lock Tracking s e B e 6 A
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Activity 2

1. Type a sentence into the document: This is the original sentence.

Home Insert Design Layout References Mailings View ACROBAT @ Tell mq
"% Spelling & Grammar ﬁ) a’ﬁ' i3 'I-:] Previous [5 5 Al Markup -
E3 Thesaurus & A Next Z [El Show Markup ~
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fizz Word Count Laokup = = Comment Show Comments Changes~ Rewewmg Pane ~
Proofing Insights Language Comments Tracking (]
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This is the original sentence.

2. Click on Track Changes.

3. Delete the sentence and add: This is a revision. A red Cursor appears in the beginning of the
sentence.

4. To view the changes, click on the red cursor. The original sentence appears along with the
revised sentence.

File Home Insert Design Layout References Mailings Review View ACROBAT @ Tell mg
5 Spelling & Grammar ﬁ) E%} @$ L 2 Previous E‘}\. Eﬁ All Markup -
EE Thesaurus A MNext Z Bl Show Markup -

. Smart | Translate Language MNew  Delete i rack )
fizzt Word Count Lookup - - TR Show Comments Changes - Reviewing Pane ~
Proofing Insights Language Comments Tracking [F]

L 1---|"‘g---l-"1---|--‘1---|--‘]---l---4---|---5-

This isthe orizinal s

5. Changes made to the document can either be accepted or rejected. Click on Accept to accept
the changes or click on Reject to reject the changes.

6. After the changes are made to the document, they can either be accepted or rejected. Click

Accept.
L = & | Previous
.
— 3" Next
Accept | Reject
Changes
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View Tab

Home Insert Design Layout References Mailings Review ACROBAT @ Tell me w you want to do...
= 7| [E] Outline [+ Ruler i One Page =1 [T View Side by Side |
[;] [] [;; . &‘D .g EEj II A ¥ CL) Ejr
= % [=] Draft Gridlines BE Multiple Pages - Sy ; =
Read | Print  Web ) Zoom 100% MNew Arrange Split - Switch Macros
Mode Layout Layout Navigation Pane ‘B Page Width Window Al Windows ~ ¥
Views Show Zoom Window Macros

e The view tab allows you to customize the way in which you view your document.

Views Group
e There are three ways to view the screen:
o Read Mode: Splits the screen in order for the document to be viewed in two pages.
o Print Layout: This is the default screen in which documents are viewed on the screen.
Documents are printed as shown.
o Web Layout: This screen allows you to view your document as a web page.

o To show the ruler on the document, check Ruler on Show/Hide group.

Q [ e

Gridlines EIE Multiple Pages
Zoom 100%
MNavigation Pane B Page Width
Show Zoom
Zoom
Zoom Group i e
e By selecting on Zoom, a window pops up with a variety of sizes to zoom in or S
out of. e
AaBbCc
DdEeXx
YyZz
. . . . . . . . AaBbCc
o To see two documents side-by-side just click on View Side by Side icon and

two documents will split on the screen.

File Home Insert Design Layout References Mailings Review View ACROBAT Q Tell me... i
| = D [=] outline  [v] Ruler Q [E) El onePage rﬂ E [ View Side by Side ED'-]
X @ [=] Draft Gridlines g Multiple Pages i i Synchrano olling i
Read | Print Web Zoom 100% New Arrange Split Switch
Made Layout Layout Navigation Pane B Page Width Window  All Reset Win Pasition  \Windows
Views Show Zoom Window
L ].---|---g‘-‘|---1-‘-|-‘-Z---l‘-‘J---l---4-‘----5---|‘-‘G---a-‘-7-‘-

To see the documents side by side just click on View Side by Side icon and two separate
documents split to fit the screen.

H 970 i=- s Basic Microsaft Office Word 2016 - Word

File Home Insert Design Layout References  Mailings  Review [NV ACROBAT  Q Tell me.

H [Eloutiine | [v] Ruler Q [‘\? [El One Page B NewWindow [T 51
E_] D D 2 o Calibri (Body) - |11 - B
o B w‘? Elpratt Gridlines B mﬂ OB Multiple Pages = Amange Al (0] ;|: . ) 0 aiticein) Adbbtede AABRCE || o
ead | Print | Wel om 100% it aste . R W.A- ing1 || Editing
Made (BRI 1 syout Navigation Pane B PageWidth | CIspiit Windos~ T |l U [ B WA LI JNormal ] ¥hoSpac. Headingl. |~ e
Views. Show Zoom Window Macros. + |Clipboard & Font n Paragraph ~ Styles & A
— e e )] S e

To see the documents side by side just click on View Side by Side icon and two separate Second document.

documents split to fit the sereen.
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The “Quick Access” Toolbar

o Located on the upper left hand corner of the page. Used to save changes made to a file, undo or
redo any changes made to the document.

e Can be customize to facilitate the quick access to other buttons.

D Camb T Aa- | A == v €
Paste g g Customization | ., . == == =
. ¥ Button A-FE=== 8
Clipboard ] Paragraph

Activity 3

Open Word 2016.
2. Type the following =rand(10,2) (this generates 10 paragraphs of text with two
sentence in each paragraph.)
Select the entire text by clicking on Ctrl + A.
Change the font of the entire document to size 14 and the font face to Times New
Roman.
Save this document as Practice Document on the desktop.
From the insert tab, add a table to your document with two rows and two columns.

Enter your name in the first cell.

| Lissette Jolalpa | |

Change the page orientation to Landscape from the Page Layout Tab.

Check the spelling and Grammar.

Short Cuts
Ctrl + A: Selects all of the text.

Ctrl + C: Copies selected text.

Ctrl + V: Pastes the text.

Ctrl + B: Makes selected text bold.
Ctrl + I: Italicizes the selected text.

Ctrl + U: Underlines selected text.

13



New Features: Microsoft Word 2016

Basic Microsoft Office Word 2016 - Word

ACROBAT Q Tell me what you want to do

Insert  Design  Layout  References
= Cambi 1 <A & |aa-| b= . == ¢ ) i
ﬁ kb A LA = =T == & AaBbCcDc| AaBbCcDe AaBb(C( AaBbCcl /—\aB AaBbCcC A4aBbCcD AaBbCcD« AoBbCcDi AaBbCeDe AaBbCcD« AaBbCcD: |
Paste z | AW === 1=- -~ 1 1 sis
e Feat P I U-aex, x| A A === |1= By - Fi Normal | TNoSpac.. Headingl ~Heading2 Title Subtitle  SubtleEm.. Emphasis IntenseE..  Strong Quote  Intense Q.. =
Clipboard Font m Paragraph n Styles

Tell me what you want to do....
You can now type in what you want to do quickly.

[ )
Type insert a header into the search box. Options for various headers appear to choose from.

°
) insert a header
¥ Built-in -
Elank

[ Add a Header
Insert Alignment Tab
E:E] Add Document Info

[Ty here]

e Get Help on "insert a header” Blank (Three Columns)

,(D Smart Lookup on "insert a he...

Ink Equation

[T e

[Ty barm]

[Ty hare]

You can write an equation using your mouse or a special device which converts your equation

[ )
into text.
e Microsoft Word 2016 was designed to work better with devices like tablets and smart phones.
e From the Insert select Equation — Ink Equation.
[# signature Line ~ f'*
[ Date & Time 57([' sg%| Eifd
o Mobject - - | e
! Built-In -
@ More Equations from Office.com »
TU Insert New Equation
Fg Ink Equation I
o Write your equation using your mouse. Insert when done.
7 =
1
x!
i
x!
| EES
B2k x!
— E’ — T
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Smart Lookup

Enables text written in Word 2016 to be searched through Bing
providing insights related to the text.
Type Microsoft Office 2016. Highlight the text.

From the Review tab select Smart Lookup.

File Home Insert Design Layout References Mailings Review View

ABC = ABC Y =2 o+
v E Ll & T
Spelling & Thesaurus Word | Smart | Translate Language Mew  Delete Previous MNext Show
Grammar Count | Lackup - - Comment Comments
Proofing nsigh Language Comments

Insights will appear on the right hand side.

Insights

Explore

Define

Microsoft Office
Microsoft Office is an office suite of

applications, servers, and services
developed by Microsoft. It was first
announced by Bill Gates on 1 August 1988,
at COMDEX in Las Vegas. Initially a

en.wikipedia.org -

Text under CC-BY-5A

Explore Wikipedia

@
R

Microsoft Office - Wikipedia, the fre...
The first Preview version of Micresoft Office
2016 for Mac was released on 5 March

2015.0n 9 July 2015 Microsoft released ©...

Web search

hitp:

Office 2

icenss

More

Microsoft Office 2016...
Microsoft Office 2016

(codenamed Office 16) is a
W version of the Microsoft ...

More

016 for Home, Students an...

are.com/store/ msusa

fen_US/c..
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